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Important Safety Information
WARNING: Never look into the projector lens when the lamp is turned on; the bright light can damage your eyes. 
Never let children look into the lens when it is on. Never open any cover on the projector, except the lamp and 
filter covers. Dangerous electrical voltages inside the projector can severely injure you. Except as specifically 
explained in this User’s Guide, do not attempt to service this product yourself. Refer all servicing to qualified service 
personnel.

WARNING: The projector and its accessories come packaged in plastic bags. Keep plastic bags away from small 
children to avoid any risk of suffocation.

Caution: When you replace the lamp, never touch the new lamp with your bare hands; the invisible residue left by 
the oil on your hands may shorten the lamp life. Use a cloth or glove to handle the new lamp.

Copyright Notice
All rights reserved. No part of this publication may be reproduced, stored in a retrieval system, or transmitted in 
any form or by any means, electronic, mechanical, photocopying, recording, or otherwise, without the prior 
written permission of Seiko Epson Corporation. The information contained herein is designed only for use with 
this Epson product. Epson is not responsible for any use of this information as applied to other products.

Neither Seiko Epson Corporation nor its affiliates shall be liable to the purchaser of this product or third parties for 
damages, losses, costs, or expenses incurred by purchaser or third parties as a result of: accident, misuse, or abuse of 
this product or unauthorized modifications, repairs, or alterations to this product, or (excluding the U.S.) failure to 
strictly comply with Seiko Epson Corporation’s operating and maintenance instructions.

Seiko Epson Corporation shall not be liable for any damages or problems arising from the use of any options or 
any consumable products other than those designated as Original Epson Products or Epson Approved Products by 
Seiko Epson Corporation.

Trademarks
Epson, Quick Corner, and Instant Off are registered trademarks, and Epson Exceed Your Vision and EasyMP are 
trademarks of Seiko Epson Corporation.

PowerLite and PrivateLine are registered trademarks; SizeWise is a trademark; and Epson Store and Epson Extra 
Care are service marks of Epson America, Inc.

Pixelworks, DNX, and the DNX logo are trademarks of Pixelworks, Inc.

General Notice: Other product names used herein are for identification purposes only and may be trademarks of 
their respective owners. Epson disclaims any and all rights in those marks.

The contents of this manual are subject to change without notice.

© 2007 Epson America, Inc. 9/07
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Welcome
The PowerLite® 1810p is an easy-to-use projector that weighs less 
than 7 pounds. The projector offers up to 3500 lumens of brightness. 
You can connect it to a wide range of computers and video sources.

Easy setup, control, and security:

■ 5-second startup time and Instant Off ® feature for fast setup and 
shut down

■ Automatic digital keystone correction

■ 1.6x optical zoom lens for flexible placement and positioning

■ Security features include password, user’s logo, and the ability to 
lock the projector buttons

■ A/V mute slide (lens cover) to block the lens and save lamp life 
when you want to temporarily stop projecting
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Using Your Documentation
This book contains all the information you need to set up and use 
your projector. Please follow these guidelines as you read through it: 

■ Warnings must be followed carefully to avoid bodily injury.

■ Cautions must be observed to avoid damage to your equipment.

■ Notes contain important information about your projector.

■ Tips contain additional projection hints.

Getting More Information

Need tips on giving presentations? Quick steps for setting up your 
projector? Here’s where you can look for help: 

■ Quick Setup sheet
Gives you the instructions you need to get your projector up and 
running if you are connecting to a notebook, MacBook,TM 
PowerBook,® or iBook® computer.

■ Projector kit
Includes this User’s Guide, your Quick Setup sheet, warranty 
brochures, and Epson PrivateLine® Support card. Keep the kit 
with your projector at all times.

■ Built-in help system
Provides assistance for common problems. Available from the 
Help button on the projector or the remote control. See page 74 
for details.

■ epson.com/support
Download FAQs and e-mail your questions to Epson support. 

■ If you still need help after checking this User’s Guide and the 
sources listed above, you can use the Epson PrivateLine Support 
service to get help fast. Call (800) 637-7661 and enter the PIN on 
the PrivateLine card. Or take advantage of Epson’s automated 
support services 24 hours a day. See page 83 for more 
information.
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■ presentersonline.com
Includes a library of articles covering presentation tips, tricks, and 
technology. The site provides templates, clip art and sound clips, 
as well as Presenters Services to use on the road. Even more 
resources and services are available if you register to join the 
Presenters Club—and it’s free. 

Registration and Warranty
Your projector comes with a basic carry-in 2-year and 90-day lamp 
warranty as well as an international warranty that let you project with 
confidence anywhere in the world. For details, see the warranty 
brochures included with your projector. 

In addition, for customers who register their projector, Epson offers 
free Extra CareSM Road Service. In the unlikely event of an equipment 
failure, you won’t have to wait for your unit to be repaired. Instead, 
Epson will ship you a replacement unit anywhere in the United States 
or Canada, usually via overnight delivery. See the brochure included 
with your projector for details.

To register, simply fill out the registration card and mail it to Epson. 
Or you can register online at epson.com/webreg. Registering also lets 
you receive special updates on new accessories, products, and service. 
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Unpacking the Projector
After unpacking the projector, make sure you have all these parts: 

Save all packaging in case you need to ship the projector. Always use 
the original packaging (or the equivalent) when you need to send the 
projector to another location. If you are moving the projector by 
hand, use the carrying case. See page 11 for ordering information, and 
page 71 for transportation instructions. 

Additional Components

Depending on how you plan to use the projector, you may need 
additional components:

■ To receive an S-video signal, you’ll need an S-video cable. 

■ To receive a component video signal from a VCR or other video 
device, you’ll need an HD15 to component video cable.

You can purchase these items from Epson. See “Optional Accessories” 
on page 11.

Projector

Remote control and 
2 AAA batteries

Power cable VGA computer cable
Carrying case

PDF manual and 
registration CD-ROM
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Optional Accessories

To enhance your use of the projector, Epson provides the following 
optional accessories:  

You can purchase screens or other accessories from an Epson 
authorized reseller. To find the nearest reseller, call 800-GO-EPSON 
(800-463-7766). Or you can purchase online at www.epsonstore.com 
(U.S. sales) or www.epson.ca (Canadian sales).

Product Part number

Replacement lamp V13H010L40

Air filter replacement set (2 filters) V13H134A08

Universal ceiling mount 
False ceiling plate
Security bracket/cabling for gyro lock mounts
Adjustable ceiling channel
Suspension adapter 

ELPMBUNI
ELPMBFCP
ELPMBSEC
ELPMBACC
ELPMBAPL

Kensington® security lock ELPSL01

50-inch portable screen (4:3 aspect ratio)
60-inch portable pop-up screen (4:3 aspect ratio)
80-inch portable pop-up screen (4:3 aspect ratio)
83.6-inch hanging pull-down screen (4:3 aspect ratio)
DUET Portable Projector Screen (4:3/16:9 combination)

ELPSC06
ELPSC07
ELPSC08
ELPSC09
ELPSC80

HD-15 to component video cable
S-video cable 

ELPKC19
ELPSV01

Distribution amplifier ELPDA01

Image presentation camera (ELPDC05) V12H162020
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1

Displaying and Adjusting 
the Image
Whether you’re presenting from a computer or video equipment, 
you need to follow some basic steps to display your image on the 
screen. 

Follow the guidelines in this chapter for: 

■ Positioning the projector

■ Turning on and off the projector 

■ Displaying an image

■ Troubleshooting display problems

■ Adjusting the image

User's Guide - 1810.book  Page 13  Monday, September 10, 2007  6:39 PM



14 Displaying and Adjusting the Image

Positioning the Projector 
If the projector isn’t already installed in the room you’re using, you’ll 
probably want to place it on a table in front of the screen, as shown. 
This lets you stand in the front of the room, face the audience, and 
remain close enough to the equipment to be able to control it. Try to 
leave as much space as possible between the projector and the screen to 
get a good-size image. 

Use the figure below to help you determine placement. Image size 
increases with distance, but can vary depending on how you position 
the zoom ring and whether you’ve adjusted the image with other 
settings. 

Also keep these considerations in mind: 

■ Place the projector on a sturdy, level surface.

■ Make sure there is plenty of space for ventilation around and 
under the projector. Do not set the projector on top of anything 
that could block the vents under the projector. 

■ Make sure the projector is within 10 feet of a grounded electrical 
outlet or extension cord. 

note
You can mount the projector 
on the ceiling, or place it 
behind a translucent screen 
for rear projection. See 
page 85 for details.

2.7 to 4.6 ft5.7 to 9.4 ft29.7 to 48.2 ft Distance from screen

 TBD
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Ideally, you should place the projector directly in front of the center of 
the screen, facing it toward the screen squarely. The base of the lens 
should be at about the level of the bottom of the screen. 

If you place the projector below screen level, you’ll have to tilt it up by 
extending the front adjustable foot. This causes the image to become 
“keystone” shaped, but you can correct the distortion (see page 22). 

For instructions on installing the projector in a permanent location, 
such as a theater or conference room, see page 85.

Turning On and Off the Projector
Turn on any connected computer or video equipment before starting 
the projector so it can automatically detect and display the image 
source. If you turn on the projector first, or have multiple pieces of 
connected equipment, you may have to select the image source 
manually (see page 18). 

note
After positioning the 
projector, you may want to 
connect a Kensington 
MicroSaver® anti-theft 
device to the lock port on the 
projector. You can purchase 
this from Epson; see 
page 11. 

Screen

Projector
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Follow these steps to turn on the projector: 

1. Open the A/V mute slide (lens cover). 

2. Plug one end of the power cable into the projector, and the other 
end into an electrical outlet.

The Power light turns orange. 

note
You can set the projector to 
automatically turn off the 
projector lamp and enter 
“sleep mode” when it has 
not received any signals for 
30 minutes. This conserves 
electricity, cools the 
projector, and extends the 
life of the lamp. If you want 
to start projecting again, 
press the P Power button. 
If you are done using the 
projector, unplug the power 
cord. To enable sleep mode, 
see page 60. 

Power light
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3. Press the PPower button on the remote control or on top of the 
projector. 

The projector beeps once and the Power light flashes green as the 
projector warms up, then an image begins to appear. When the 
Power light stops flashing and remains green, the projector is 
ready for use. 

4. If you are prompted to enter a password, see page 57.

Using the Direct Power On Function

The Direct Power On function enables faster setup. The projector 
starts up automatically when you plug it in or turn it on with a wall 
switch. You don’t have to press the PPower button. 

Follow these steps to enable Direct Power On: 

1. Press the Menu button on the remote control or projector and 
select the Extended menu. 

2. Choose Operation and press Enter. 

3. Choose Direct Power On and press Enter.

4. Highlight On and press Enter. 

5. Press Menu to exit. The setting will take effect the next time you 
plug in the projector.

warning
Never look into the lens 
when the lamp is on. This 
can damage your eyes, and is 
especially dangerous for 
children.

note
If a power outage occurs 
when Direct Power On is 
enabled and the projector is 
plugged in, the projector will 
start when the power is 
restored.
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Shutting Down the Projector

This projector incorporates Instant Off technology. To turn it off, you 
can press its P Power button as described below, unplug it, or turn 
off a power switch that supplies power to the projector. You don’t 
have to wait for the projector to cool off first. 

1. To turn off the projector, press the PPower button on the 
remote control or projector. 

You see a confirmation message. 
(If you don’t want to turn it off, 
press any other button.)

2. Press the PPower button again. The 
projection lamp turns off and you can unplug the power cord. 

If you want to turn the projector on again, make sure the orange 
Power light is not flashing, then press the PPower button.

Displaying an Image
You may need to select the image source if you have multiple video 
sources connected to the projector (such as a computer or DVD 
player). Selecting the image source lets you switch between images 
input from different pieces of connected equipment. 

If you don’t see the image you want, press the Search button on the 
remote control or the Source Search button on the projector until 
you see the image you want to project. 

You can also use the Source buttons on the remote control to switch 
between devices connected to the ports identified on each button. The 
PowerLite 1810p does not support EasyMP.TM 

note
Lamp life results will vary 
depending on mode selected, 
environmental conditions, 
and usage.

Turn off this product when 
not in use to prolong the life 
of the projector. 
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Troubleshooting Display Problems
Follow these guidelines if you’re having trouble displaying an image. 

You Can’t Project an Image

If you don’t see the image you are trying to project, try the following: 

■ Make sure the cables are connected correctly, as described 
beginning on page 35.

■ Make sure the Power light is green and not flashing and the A/V 
mute slide (lens cover) is open. 

■ If you’ve connected more than one computer and/or video source, 
you may need to press the Source Search button on the 
projector’s control panel or Search button on the remote control 
to select the correct source. (Allow a few seconds for the projector 
to sync up after pressing the button.)

■ If you’re using a PC notebook, press the function key on your 
keyboard that lets you display on an external monitor. It may be 
labeled CRT/LCD or have an icon such as . You may have to 
hold down the Fn key while pressing it. Allow a few seconds for 
the projector to sync up after changing the setting. 

The Projector and Notebook Don’t Display the 
Same Image

If you’re projecting from a notebook, and you can’t see your image on 
the projection screen and on your computer at the same time, follow 
these guidelines.

If you’re using a PC notebook:
■ On most systems, there’s a function key that lets you toggle 

between the LCD screen and the projector, or display on both at 
the same time. It may be labeled CRT/LCD or have an icon such as 

. You may have to hold down the Fn key while pressing it. 
Allow a few seconds for the projector to sync up after changing 
the setting. 
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■ If the function key doesn’t permit you to display simultaneously 
on both screens, you should check your monitor settings to make 
sure both the LCD screen and the external monitor port are 
enabled. 

From the Control Panel, open the Display utility. In the Display 
Properties dialog box, click the Settings tab, then click 
Advanced. The method for adjusting the settings varies by 
brand; you may need to click a Monitor tab, then make sure the 
external Monitor port is set as your primary display and/or 
enabled. See your computer’s documentation or online help for 
details. 

If you’re using Mac OS X:
You may need to set up your system to display on the projector screen 
as well as the LCD screen. Follow these steps:

1. From the Apple® menu, select System Preferences, then select 
Displays.

2. Make sure the VGA Display or Color LCD dialog box is selected.

3. Click the Arrangement (or Arrange) tab.

4. Make sure the Mirror Displays checkbox is selected. 

Make sure 
Mirror Displays 
is checked
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Adjusting the Image
Once you see your image, you need to make certain adjustments:    

■ If the image is too high or too low, reposition it as described 
below.

■ To focus or zoom your image, see page 22. 

■ If the image isn’t square, see page 22.

■ To quickly adjust the color, brightness, or contrast, see page 25.

■ To change the image aspect ratio, see page 26.

■ If you need to fine-tune the image and/or sound, see Chapter 4.

Adjusting the Height of the Image

If the image is too low on the screen, you can use the front adjustable 
foot to raise it. 

1. Stand behind the projector. Press the foot release lever up and lift 
the front of the projector. 

2. Once the image is positioned where you want it, release the lever 
to lock the foot in position.

3. If necessary, you can fine-tune the height or level the image by 
turning any of the projector’s adjustable feet. 

Raising the projector causes the image to distort or “keystone,” but 
you can correct the shape as described on page 22. 
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Focusing and Zooming the Image

Turn the focus ring on the projector to sharpen the image. 

Turn the zoom ring on the projector to reduce or enlarge the image. 

If the image still isn’t large enough, you may need to move the 
projector farther away from the screen. You can also use the E-Zoom 
buttons on the remote control to zoom in on a portion of the image. 
See page 30 for instructions. 

Adjusting the Image Shape

You can maintain a square or rectangular image by placing the 
projector directly in front of the screen and keeping it level. This also 
produces the best picture quality. If the projector is tilted up or placed 
at an angle, you’ll need to correct the image shape by using one of the 
functions described below. 

Automatic Image Adjustment
Use the projector’s Quick Setup feature to set up quickly for a 
presentation. This function automatically corrects the shape and 
position of the image to fit on a screen with a 4:3 aspect ratio. It can 
correct image distortion when the projector is placed up to a 45° angle 
to the screen (vertically) and 20° (horizontally).

1. Press the Quick Setup button on the projector’s control panel.

Focus Zoom 
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You see a projected message:

2. Aim the projector so the message appears near the middle of the 
screen. Then use the zoom ring to enlarge the image so the white 
frame (not shown above) extends beyond the edges of the screen 
on all sides.

3. Press the Quick Setup button again. Two white boxes flash 
momentarily onto the screen, and the adjustment is complete. 
Your projected image now fits on the screen (some slight overlap 
is normal).

The Quick Setup adjustment is retained when the projector is turned 
off. If the projector is installed in a fixed location, you won’t need to 
repeat the adjustment each time you turn it on. To fine-tune the 
Quick Setup adjustment, use Quick Corner® (below).

Using Quick Corner
Use Quick Corner to adjust the shape and size of the image when it’s 
uneven on all sides, or to finely adjust the image after performing 
Quick Setup. If you just used Quick Setup, you can use the projector’s 
arrow buttons to make the Quick Corner adjustment. If not, you’ll 
have to select Quick Corner as follows: 

1. Press the Menu button on the remote control or on the 
projector’s control panel.

2. Select the Settings menu and press Enter. 

3. From the Settings menu, select Keystone and press Enter. 

4. Select Quick Corner and press Enter.

note
If Quick Setup did not 
detect the edges of your 
screen (for example, if you’re 
projecting on a wall), then 
the arrow buttons will be in 
Keystone correction mode 
after performing Quick 
Setup (see page 24).
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You see this screen:

5. Use the pointer button on the remote control (or the arrow 
buttons on the projector) to select the corner you want to adjust, 
and press Enter.

6. Use the pointer button on the remote control (or the arrow 
buttons on the projector) to adjust the shape. 

7. Repeat steps 5 and 6 as needed to adjust any remaining corners. 

8. When done, press Menu to exit the menu system.

Using Keystone Correction
The projector automatically corrects vertical keystone distortion when 
it is tilted within a range of 30° up or down. 

It takes about one second after projection starts for the image to be 
corrected. During this time, a vertical keystone correction gauge 
appears on the screen. If keystone correction isn’t automatically 
carried out, you may need to turn on the Auto V-Keystone setting in 
the projector’s menu system (see page 54).

Corrected imageProjector tilted up Projector tilted down
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You can manually adjust the shape of the image to compensate for 
vertical and horizontal keystone distortion. First make sure the 
Keystone setting in the projector’s menu system is set to H-Keystone 
or V-Keystone: 

1. Press the Menu button on the remote control (or on the 
projector’s control panel).

2. Select the Settings menu and press Enter. 

3. From the Settings menu, select Keystone and press Enter. 

4. Select H/V-Keystone and press Enter.

5. Select H-Keystone (for horizontal adjustment) or V-Keystone 
(for vertical adjustment) and use the l and r arrow buttons to 
adjust the shape of the image.

If the image becomes smaller, use the zoom ring to enlarge the image 
so it fits the screen. If the image contains faint lines or a gridlike 
pattern, decrease the sharpness setting (see page 51). 

Selecting the Color Mode

The Color Mode adjusts the brightness, contrast, and color for various 
common viewing environments. Use this setting to quickly obtain a 
good picture.

note
The projector’s arrow 
buttons may already be in 
Keystone correction mode if 
you haven’t used Quick 
Setup or Quick Corner.

Vertical 
keystone 
adjustment

Horizontal 
keystone 
adjustment
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Press the Color Mode button on the remote control, and then select 
from one of these options:

■ Presentation: For making color presentations in a bright room. 

■ Text: For making black-and-white presentations in a bright 
room. 

■ Theatre: For watching movies in a darkened room; gives images a 
natural tone. 

■ Photo: For vivid, high-contrast still images in a bright room. 

■ Sports: For vivid TV images projected in a bright room (video, 
S-video, or composite video only). 

■ Game: Increases brightness when playing video games or 
watching TV in a bright room. Emphasizes dark gradations. 

■ sRGB: Matches the color palette of standard sRGB computer 
displays. 

■ Blackboard: Projects accurate colors on a green chalkboard 
(adjusts the white point).

■ Customized: For manual color adjustment (see page 51). 

Resizing Video Images

You can use the Resize button on the remote control to adjust how 
an image fits into the display area. 

Press Resize to switch the aspect ratio between 4:3 and 16:9. This lets 
you play certain digital video images or movies recorded on certain 
DVDs in 16:9 widescreen format. You can also select 16:9 (Up) or 
16:9 (Down) to reposition videos to accommodate subtitles or 
supertitles.

For computer images, select Normal to automatically resize the image 
and make the best use of the display area. 
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Presenting with the Remote 
Control
The projector includes a number of tools to enhance your 
presentation. All of them can be accessed using the remote control, 
which lets you operate the projector from anywhere in the room—up 
to 20 feet away. 

You can use the remote control to adjust the picture and sound 
(page 28) or as a pointer to highlight your presentation (page 31). You 
can also use it as a wireless mouse when projecting from a computer 
(page 32), or to control two or more projectors at the same time 
(page 33). 

This chapter covers:

■ Using the remote control

■ Controlling the picture and sound

■ Highlighting your presentation

■ Operating your computer with the remote control

■ Operating two or more projectors with the remote control
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Using the Remote Control
Make sure batteries are installed as described on page 70. Follow these 
tips for using the remote control: 

■ Point the remote control at the front of the projector or at the 
screen.

■ Stand within 20 feet of the projector. 

■ Avoid using the remote under bright fluorescent lamps or in 
direct sunlight, or the projector may not respond properly.

Controlling the Picture and Sound
You can use the remote control to preview and select your picture 
sources, temporarily turn off the picture and sound, freeze the action, 
zoom in on the picture, and adjust the volume. 

Switching Between Picture Sources

If your projector is connected to more than one computer and/or 
video source, you can switch between the different sources: 

■ The easiest way to select your source is to press the Search button 
on the remote control (or the Source Search button on the 
projector) repeatedly until you see the image you want on the 
screen. 

■ On the remote control, there are several Source buttons. 
Use them to switch between equipment connected to the port 
identified on each button, or to use EasyMP (PowerLite 1815p 
only).

note
If a button is pressed longer 
than 30 seconds, the remote 
control stops operating to 
conserve power. When you 
release the button, normal 
operation resumes. 
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After you select a source, the screen goes dark for a moment before the 
image appears.

Turning Off the Picture and Sound 

You can temporarily turn off the image and sound when you want to 
redirect your audience’s attention. There are two ways to do this: 

■ Close the A/V mute slide, as shown below:

■ Press the A/V Mute button on the remote control. This turns the 
image black and stops the sound. To turn the image and sound 
back on, press the button again.

You can have the screen turn blue when you press the A/V Mute 
button. You can also have an image, such as a company logo, 
display on the screen (see page 57).
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Stopping Action

You can use the remote control to stop the action in your video or 
computer image. 

■ To stop the action and keep the current image on the screen, press 
the Freeze button. The sound continues. 

■ To restart it, press the Freeze button again. 

Zooming Part of Your Image

You can zoom in on a portion of the image using the E-Zoom buttons 
on the remote control. 

1. Press the E-Zoom  button on the remote control. 

You see a crosshair indicating the center of the zoom-in area.

2. Use the pointer button to position the crosshair.

3. Continue pressing the E-Zoom  button to enlarge the selected 
area up to 4 times.

4. While the image is enlarged, you can:

■ Use the pointer button to move around the screen.

■ Press the E-Zoom  button to zoom out. 

5. When done, press the ESC button to return the image to its 
original size.

note
This function pauses the 
image, not the sound. 
Because the source continues 
to transmit signals, when 
you resume the action, it 
won’t be at the point you 
stopped it.
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Controlling the Volume

To change the volume, press the  or  button on the remote 
control. 

You can also adjust the volume using the projector’s menu system. See 
page 54. 

Highlighting Your Presentation
You can display a pointer to call out important information on the 
screen. If you want to customize the pointer tool, you can choose from 
three alternative shapes.

Using the Pointer Tool

1. To activate the pointer tool, press the Pointer button on the 
remote control. A pointer appears on the screen.

If you prefer to use a different style of pointer, see the instructions 
in the next section.

2. Use the pointer button on the remote control to position the 
pointer on the screen. 

note
To temporarily shut off the 
sound and picture, press the 
A/V Mute button or close 
the A/V mute slide.

Pointer
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3. When you’re done using the pointer, press Esc to clear the screen.

Customizing the Pointer Tool

You can change the appearance of the pointer by choosing from three 
alternative shapes. 

1. Press the Menu button on the remote control, highlight the 
Settings menu, highlight Pointer Shape, and press Enter. You 
can select one of the pointer shapes shown at the left.

2. Select the shape you want and press Enter.

3. Highlight Return and press Enter. 

4. Press Menu to exit from the menu system. 

Operating Your Computer with the 
Remote Control
If you connect a computer to the projector with a USB cable, you can 
use the remote control in place of your computer’s mouse. This gives 
you more flexibility when delivering slideshow-style presentations, 
since you won’t have to stand next to the computer to change slides. 

■ Use the  Up and  Down buttons to move through a 
Microsoft® PowerPoint® slideshow. 

Page up or down 
to change slides 
in PowerPoint

Right-click

Left-click

Use to move pointer 
on screen

Left-click
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■ Use the  pointer button to move the pointer on the screen.

■ Press the Enter button once to left-click, or press it twice to 
double-click. Press the Esc button to right-click.

■ To drag-and-drop, hold down the Enter button. Then use the 
 pointer button to drag the object. When it’s where you want it, 

release the Enter button.

Operating Two or More Projectors with 
the Remote Control
If you’re using more than one projector, you can control all the 
projectors—or just selected ones—by using the projector ID system. 
To operate a projector, you have to set the remote control’s ID to 
match that of the projector. Or you can control all the projectors at 
once by setting the remote control’s ID to zero. 

Setting the Projector ID

The projector’s default ID is set to Off. This lets it respond to 
commands from any remote control. To change the ID, follow these 
steps:

1. Press the Menu button on the remote control. You see the 
projector’s menu screen. 

2. Select Extended > Projector ID.

3. Use the pointer button to highlight the new ID, and press 
Enter to select it.
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4. When done, press Menu to exit the menu system.

Setting the Remote Control ID

The remote control’s default ID is zero. This lets you operate any 
projector. To set it to operate a specific projector, follow these steps:

1. Point the remote control at the projector you want to be able to 
operate.

2. Press and hold the ID button on the remote control.

3. While holding the ID button, press a numbered button on the 
remote control (0 through 9) to select the desired ID. Select zero 
to control all projectors, or select a number to match the ID of the 
projector(s) you want to operate.

After setting the ID, you can check whether the remote control works 
with a specific projector:

1. Point the remote control at the projector you want to check.

2. Press the ID button on the remote control. You see a message on 
the screen like one of these: 

If the message says the remote control is “On,” then you can use 
the remote control to operate that projector. If it says “Off,” then 
you have to change the ID of the remote control and/or projector 
before operation is possible. 

note
If you’re using a remote 
control ID other than the 
default ID of zero, you have 
to set the ID each time you 
turn on the projector.
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Connecting to Computers 
and Other Equipment
This chapter tells you how to connect the projector to a notebook or 
desktop computer, and/or to video equipment, such as a VCR, DVD 
player, or video camera. 

Follow the instructions in this chapter on:

■ Connecting to a computer

■ Connecting video equipment

■ Connecting an external monitor

■ Playing sound through the projector
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Connecting to a Computer
You can connect the projector to any computer that has a standard 
video output (monitor) port, including desktop models, PC notebook 
computers, MacBook, PowerBook, and iBook computers, and 
hand-held devices. 

If you want to use the projector’s remote control as a wireless mouse to 
operate your computer during presentations, see page 37.

Connecting to the Computer Port

You can connect to the projector using the VGA computer cable that 
came with it (the monitor port on your computer must be a mini 
D-sub 15-pin port). 

1. If you’re using the VGA computer cable, connect one end to the 
projector’s Computer1 or Computer 2 port, and the other end 
to your computer’s monitor port.

 

2. You may need to change the Computer1 Input or Computer2 
Input setting in the projector’s Signal menu to RGB (see 
page 53). 

3. You can connect an optional stereo mini-jack audio cable to play 
sound through the projector (see page 44), or connect a USB 
cable to use the remote control as a mouse (see page 37).

caution
Don’t try to force a 
connector to fit a port with a 
different shape or number of 
pins. You may damage the 
port or connector.
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4. When you’ve finished making any connections, see page 15 for 
instructions on turning on the projector and adjusting the 
image.

Connecting the Cable for Remote Mouse 
Control

If you’ve connected a computer as described in this chapter (using the 
Computer 1 or Computer 2 port), you can use the projector’s 
remote control as a wireless mouse. This lets you control your 
computer and click through slideshow-style presentations, such as 
PowerPoint, from up to 20 feet away. 

The wireless mouse function is supported on systems with a USB port 
running Windows Vista,TM Windows XP, 98SE, Me, or 2000, or Mac 
OS X 10.2.x to 10.4.x. 

1. Connect the square end of a USB cable to the projector’s 
USB port. 

2. Connect the flat end of the cable to any available USB port on 
your notebook or desktop computer.

3. If necessary, configure your computer to work with an external 
USB mouse. See your computer documentation for details. 

note
For details on how to use the 
remote control in place of 
your computer’s mouse, see 
page 32. 

Move 
cursor

Left- 
click

Right- 
click

USB cable

User's Guide - 1810.book  Page 37  Monday, September 10, 2007  6:39 PM



38 Connecting to Computers and Other Equipment

Connecting to Video Equipment 

You can connect several video sources to the projector at the same 
time. Before starting, look at your video equipment to determine its 
available video output connections: 

■ If your video player has a yellow RCA-style video output 
connector, see “Connecting a Composite Video Source” on 
page 39.

■ If your video player has an S-video connector, see “Connecting an 
S-Video Source” on page 40.

■ If your video player has a component video port (three connectors 
labeled either Y/Cb/Cr or Y/Pb/Pr), see “Connecting a 
Component Video Source” on page 41.

■ If your video player has an RGB video port (either a single 
connector for a VGA-style monitor cable or three connectors 
labeled R/G/B), see “Connecting an RGB Video Source” on 
page 42.

After connecting video cables, you may also want to connect an audio 
cable to play sound through the projector; see page 44. 

RCA connector 
(composite video)

S-video 
connector 

VGA connector 
(RGB video)

User's Guide - 1810.book  Page 38  Monday, September 10, 2007  6:39 PM



Connecting to Computers and Other Equipment 39

Connecting a Composite Video Source

1. Locate an RCA-style video cable (one is usually provided with 
your video equipment or you can purchase one from an 
electronics dealer).

2. Connect the cable to the yellow video output connector on your 
player and the yellow Video connector on the projector:

3. If you want to play sound through the projector, see page 44 for 
instructions on connecting audio cables.

4. If you don’t need to make any other connections, see page 15 for 
instructions on turning on the projector and adjusting the image. 
Once the projector is turned on, select the image source: press the 
Search button on the remote control or press the Source 
Search button on the projector’s control panel repeatedly until 
the image appears. 
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Connecting an S-Video Source

1. Locate an S-video cable (one is usually provided with your video 
equipment or you can purchase one from Epson; see page 10). 

2. Connect the cable to the S-video connector on your player and 
the S-Video connector on the projector:

3. If you want to play sound through the projector, see page 44 for 
instructions on connecting audio cables.

4. If you don’t need to make any other connections, see page 15 for 
instructions on turning on the projector and adjusting the image. 
Once the projector is turned on, select the image source: press the 
Search button on the remote control or press the Source 
Search button on the projector’s control panel repeatedly until 
the image appears. 
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Connecting a Component Video Source

You will need a special cable to connect your component video 
equipment to the HD15 (VGA-style) connector on the projector. You 
can order the HD15 to component cable (ELPKC19) from Epson; see 
page 11 for more information. 

1. Locate an HD15 to component video cable or adapter. 

2. Connect the cable to your player and the Computer 1 or 
Computer 2 connector on the projector. 

3. You may need to change the Computer1 Input or Computer2 
Input setting in the projector’s Signal menu to Component 
(see page 53).

4. If you want to play sound through the projector, see page 44 for 
instructions on connecting audio cables.

5. If you don’t need to make any other connections, see page 15 for 
instructions on turning on the projector and adjusting the image. 
Once the projector is turned on, select the image source: press the 
Search button on the remote control or press the Source 
Search button on the projector’s control panel repeatedly until 
the image appears. 

note
Be sure your video player is 
not an RGB video source. 
If you select the wrong 
source, image quality may 
suffer. Check your video 
player’s documentation.

Also, make sure the 
Computer Input setting in 
the Signal menu is set to 
Auto or Component Video 
(see page 53).

HD15 to component cable 
(ELPKC19)

HD15 to component 
adapter
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Connecting an RGB Video Source

1. Locate the VGA computer cable provided with the projector. 

2. Connect the cable to the video port on your player and 
the Computer1 or Computer2 port on the projector.

3. You may need to change the Computer1 Input or 
Computer2 Input setting in the projector’s Signal menu
to RGB (see page 53).

4. If you want to play sound through the projector, see page 44 for 
instructions on connecting audio cables.

5. If you don’t need to make any other connections, see page 15 for 
instructions on turning on the projector and adjusting the image. 
Once the projector is turned on, select the image source: press the 
Search button on the remote control or press the Source 
Search button on the projector’s control panel repeatedly until 
the image appears. 

note
Be sure your video player is 
not a component video 
source. If you select the 
wrong source, image quality 
may suffer. Check your 
video player’s 
documentation.
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Connecting an External Monitor
If you want to monitor your computer presentation close-up (on a 
monitor placed beside the projector) as well as on the screen, you can 
connect an external monitor. You can use it to check on your 
presentation even if you’ve pressed the A/V Mute button or switched 
to a different picture source. 

First make sure your computer’s VGA cable is connected to the 
projector’s Computer1 port (see page 36). Then connect your 
monitor to the projector’s Monitor Out port, as shown:

 

note
The monitor cannot display 
component video, nor 
computer images via the 
Computer2 port.

Some LCD monitors may 
not be able to display the 
image correctly. If you have 
trouble displaying the 
image, connect a multiscan 
monitor. If you’re projecting 
computer images, make sure 
the computer’s refresh rate is 
set to 65 Hz or greater.
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Playing Sound Through the Projector
You can play sound through the projector’s speaker system or attach 
an external speaker system.

To play sound through the projector, follow these steps:

1. Locate the appropriate cable and connect it to the Audio jack on 
the projector.

■ If you have equipment connected to the Computer 1 or 
Computer 2 port, use a stereo mini-jack cable. Connect the 
cable to the Audio1 port (for Computer1) or the Audio2 
port (for Computer2).

■ If you have equipment connected to the Video or S-Video 
port, connect an RCA-style audio cable to L-Audio-R.

  

2. Connect the other end of the cable to the audio output 
connector(s) on your computer or video equipment. 
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Connecting External Speakers

You can output sound to external speakers with built-in amplifiers. 
When you play sound through external speakers, the projector’s 
built-in speaker system is disabled.

1. Locate the appropriate cable to connect your speakers. 

Depending on your speakers, you may be able to use a 
commercially available audio cable with a stereo mini-jack 
connector on one end and pin jacks on the other end. For some 
speakers, you may have to purchase a special cable or use an 
adapter.

2. Connect the stereo mini-jack end of the audio cable to the Audio 
Out port on the projector. 

  

3. Connect the other end of the cable to your speakers. 

The projector’s internal speaker system is disabled while sound is 
output to external speakers. You can use the remote control to adjust 
the volume. 
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Fine-Tuning the Projector
You can use the projector’s on-screen menus to adjust the image, 
sound, and other features. This chapter covers the following 
information: 

■ Using the menu system

■ Adjusting the image

■ Adjusting signal settings

■ Customizing projector features

■ Using the projector security features

■ Customizing power and operation

■ Multi-screen color adjustment
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Using the Menu System
You can use the remote control or the projector’s control panel to 
access the menus and change settings. Follow these steps:

1. To display the menu screen, press the Menu button on the 
remote control or on the projector.  

You see a menu screen similar to the one below: 

The menus are listed on the left and the options available for the 
highlighted menu are shown on the right.

2. Use the pointer button on the remote control (or the 
navigational buttons on the projector) to scroll through the menu 
list. When you’ve highlighted the desired menu, press the Enter 
button to select it. 

3. Once you’ve selected the menu, use the pointer button to 
scroll through the list of options. (Some of the options may be 
grayed out or unavailable, depending on the selected source.)

note
The Network menu does not 
appear on the 1810p. 

Menu list

Options
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4. After highlighting the option you want to adjust, use the 
pointer button to change the setting. In some cases, you may 

have to press the Enter button to view a sub-screen for changing 
the setting. 

■ Press the left or right side of the pointer button to adjust
a slider bar.

■ To select from two or more settings, use the pointer 
button to highlight the desired setting and press Enter. 

5. After changing the settings, press the Esc button to save your 
changes and return to the previous menu (or press it repeatedly to 
exit the menu system). 

You can also press the Menu button to exit. 

Restoring the Default Settings 

You can use the menu system’s Reset options to restore the factory-
default settings for all the settings listed in a specific menu, or all the 
settings in all menus.

To restore the settings in a specific menu, enter the menu whose 
settings you want to change, select Reset, and confirm as needed. 
(The example below shows how to reset the Image menu.) 

To restore all the projector settings to their factory-default values, 
select the Reset menu, highlight Reset All, and press Enter. 

Reset settings
for current menu

Reset settings for
all menus

note
When you select Reset All 
in the Reset menu, it does 
not reset the Computer 
Input, User’s Logo, 
Multi-screen, Language, 
Lamp Hours, or Network 
settings.
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Adjusting the Image 
You can use the Image menu to adjust the brightness, sharpness, color, 
tint, and contrast. 

1. Press the Menu button on the projector or remote control and 
select the Image menu. You see the Image menu screen. 

2. Use the pointer button to highlight the desired option, then 
adjust it as needed:

■ Color Mode
Lets you quickly adjust the color and brightness for various 
environments. Use either the remote control or the Color 
Mode setting in the Image menu. You can save a different 
setting for each source. Select from these settings:

Game: Ideal for use in bright rooms and when playing video 
games, this mode produces the brightest images and most 
vivid colors. 

Presentation: For making presentations with color materials 
in bright rooms. 

Text: For making presentations with black-and-white 
materials in bright rooms. 

Theatre: For watching movies in a darkened room; gives 
images a natural tone. 

Photo: For vivid, high-contrast still images in a bright room. 

Sports: For vivid TV images projected in a bright room. 

note
The available settings vary 
depending on the input 
source selected.
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sRGB: For matching the color palette of standard sRGB 
computer displays. 

Blackboard: For projecting accurate colors on a green 
chalkboard (adjusts the white point).

Customized: For manual color adjustment (see below). 

■ Brightness 
Lightens or darkens the overall image. 

■ Contrast
Adjusts the difference between light and dark areas. 

■ Color Saturation
Adjusts the color depth of the image. 

■ Tint
Adjusts the balance of green to magenta in the image. 

■ Sharpness
Adjusts the sharpness of the image. 

■ Abs. Color Temp.
Sets a color temperature between 5000 and 10000 °K. (Not 
available if sRGB is selected as the Color Mode setting.) 

■ Color Adjustment
Adjusts the color values. For Customized color mode, select 
RGBCMY to adjust individual red, green, blue, cyan, 
magenta, and yellow hue and saturation values. For other 
color modes, RGB may be selected to adjust red, green, and 
blue hue and saturation values. (Not available if sRGB is 
selected as the Color Mode setting.)

Six-Axis Color Adjustment

For special projection material, such as high-quality photographs or 
artwork, you can adjust the hue and saturation for six different color 
axes. 

1. Follow the instructions on page 50 to open the Image menu and 
select Color Mode.

note
The Brightness setting 
changes the opacity of the 
projector’s LCD panels. You 
can also change the lamp’s 
brightness. Select 
Brightness Control in the 
Settings menu, then choose 
High or Low (the default 
setting is High).

User's Guide - 1810.book  Page 51  Monday, September 10, 2007  6:39 PM



52 Fine-Tuning the Projector

2. Press the Enter button to select Customized, then press Esc to 
return to the Image menu.

3. Select Color Adjustment and press Enter. You see hue and 
saturation controls on the screen for six colors: RGBCMY (red, 
green, blue, cyan, magenta, and yellow).

4. Select the color axis you want to adjust and press Enter. You see 
color controls for hue and saturation. 

Hue changes the balance of color, and saturation changes the 
strength of the color.

5. Use the pointer button to adjust the hue and saturation. You 
see the adjustments reflected on the screen. When you are satisfied 
with the color, press Esc.

6. Repeat steps 4 and 5 for each color axis you want to adjust.

You may need to readjust the color as the lamp in your projector 
changes over time.

Adjusting Signal Settings
Although the projector normally detects and optimizes the input 
signal automatically, you can use the Signal menu to make manual 
adjustments. In addition to changing the position of the projected 
image, you can correct tracking and sync for computer images, or 
change the aspect ratio to widescreen format for video images. 

1. Press the Menu button and select the Signal menu. 

You see a screen similar to one of those below. (The settings will 
be different depending on the source you are projecting from.)

Computer/RGB Video Composite Video/S-Video
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2. Use the pointer button to highlight the desired option, then 
adjust it as needed:

■ Auto Setup 
Leave this setting On to automatically optimize computer 
images. Turn it off if you want to save adjustments you have 
made to the Tracking, Sync, and Position settings.

■ Tracking 
Adjust this value to eliminate vertical stripes in computer 
images.

■ Sync
Adjust this value if computer images appear blurry or flicker.

■ Progressive
For composite video and S-video only. Turn this setting On 
to convert interlaced signals into progressive signals (best for 
still images). Leave the setting Off for moving images.

■ Position
If the image is slightly cut off on one or more sides, it may not 
be centered exactly. Select this setting and use the pointer 
button to center it.

■ Computer1 Input
Computer2 Input
If the colors don’t look right on the Auto setting, select the 
setting for the type of equipment you’ve connected to the 
Computer1 or Computer2 port:

RGB: For a computer or RGB-video connection.

Component: For a video player that outputs a component 
video signal (with connectors labeled Y/Cb/Cr or Y/Pb/Pr).

■ Video Signal 
Leave this setting at Auto unless you are using a 60-Hz PAL 
system (then select PAL60).

■ Resize
Choose an aspect ratio of either 4:3 or 16:9. For videos, you 
can also select 16:9 (Up) or 16:9 (Down) to accommodate 
subtitles or supertitles. Normal is the default setting for a 
computer connection. 

note
You can also use the remote 
control’s Auto button to 
automatically reset the 
projector’s Tracking, Sync, 
and Position settings. See 
page 81 for details.
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Customizing Projector Features
You can use the Settings menu to lock the buttons on the projector, 
adjust audio volume, and customize several other features.

■ Keystone 
Adjusts the shape of the image if the projector has been tilted 
upward or placed at an angle to the screen.

Select H/V-Keystone to correct horizontal and vertical keystone 
distortion, or to turn Auto V-Keystone on or off (see page 24).

Select Quick Corner to adjust the shape and position of the 
projected image (see page 23).

■ Operation Lock
Lets you disable all of the buttons on the projector except the 
PPower button. See page 59 for more information.

■ Pointer Shape
Lets you choose from three pointer shapes. See page 31 for more 
information.

■ Brightness Control
Lets you select from two levels of brightness. The Low setting 
reduces power consumption and noise, and extends the lamp’s 
operating life.

■ Volume
Raises or lowers the volume of the projector’s speaker.

note
You can also adjust the 
volume using the remote 
control.
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■ Remote Receiver
Deactivates the projector’s front and/or back sensors that detect 
signals from the remote control. Use this setting to prevent use of 
the remote control or to stop interference from bright fluorescent 
lights.

■ Test Pattern
Displays a test pattern for use when adjusting the zoom and focus, 
and when performing keystone correction.

Using the Projector Security Features
To prevent unauthorized use of the projector, you can do the 
following:

■ Assign a password. You can use the password to prevent the 
projector from being turned on, and to prevent your custom 
startup screen from being changed.

■ Create a custom screen that is displayed at startup and/or when 
the A/V Mute button is pressed. The screen can be locked with a 
password to discourage theft and provides a way to identify the 
projector should it be stolen. See page 57. 

■ Disable the projector’s buttons; this is useful, for example, if 
you’re projecting in a classroom and you want to ensure that no 
one touches the projector’s buttons while you’re using the remote 
control. See page 59. 

Enabling Password Protection

The default setting for the password is 0000. Follow these steps to 
create a new password:

1. Press the Freeze button on the remote control for about five 
seconds.

note
You can also attach a 
security cable to the 
projector to prevent theft 
(see page 86).

caution
If you lose the remote 
control, you will not be able 
to enter the password. Keep 
the remote control in a safe 
place at all times. Also, it’s a 
good idea to write down 
your password. 

User's Guide - 1810.book  Page 55  Monday, September 10, 2007  6:39 PM



56 Fine-Tuning the Projector

You see this screen:

2. Use the  pointer button to select Password and press Enter.

3. When you see a message asking if you want to change the 
password, select Yes and press Enter.

4. Hold down the Num button on the remote control and use 
the numeric keypad to enter a four digit password. (The default 
setting is 0000.) 

5. When you see a confirmation message, reenter the password. 
Then press the Menu button to exit the screen.

To set security options, access the Password Protect screen as 
described above, and then turn on any of the following options:

■ Power On Protect to prevent unauthorized use of the projector. 
After the projector is plugged in and turned on, you must enter a 
password to use the projector. For details, see page 57.

■ User’s Logo Protect to prevent your custom screen and display 
settings from being changed. None of the User’s Logo features in 
the Extended menu can be changed when the User’s Logo Protect 
function is enabled. For details on creating a custom screen, see 
page 57.

note
Network Protect is not 
available for the 1810p 
projector. 

Hold down
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Starting the Projector with a Password

When the password function is enabled, you see this screen when you 
plug in and turn on the projector:

Hold down the Num button on the remote control and use the 
numeric keypad to enter the four digit password. The password screen 
closes and projection begins. 

If the password is not correct, you see a message prompting you to 
re-enter the password. If you enter an incorrect password three times 
in succession, you see the message The projector’s operation will be 
locked and the projector switches to standby mode. Disconnect the 
projector’s power cord from the electrical outlet, reconnect it, and 
turn the projector back on. 

When you see the Password screen again, you can try to enter the 
correct password.

If you enter an incorrect password 30 times in succession, the 
projector remains locked and you must contact Epson to unlock it. 

If you have forgotten the password, contact Epson with the request 
code number that appears in the Password screen for assistance. See 
“Where To Get Help” on page 83.

Creating Your Own Startup Screen

You can transfer any image from your computer or video source to the 
projector and then use it as your startup screen. You can also use it as 
the screen displayed when the projector is not receiving a signal or 
when you press the A/V Mute button. The image can be a company 
logo, slogan, photograph, or any other image you want to use. 

note
If you leave the projector 
plugged in, the Password 
Protect Release screen will 
not appear. It appears only 
if you unplug and reconnect 
the power cable.

Hold down
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Capturing the Image

Start by displaying the image you want to use from either a computer 
or video source, such as a DVD player. Then follow these steps to 
capture the image and transfer it to the projector: 

1. Press the Menu button on the remote control, highlight the 
Extended menu, and press Enter.

2. Highlight User’s Logo and press Enter. 

3. When you see a message asking Choose this image as the 
user’s logo?, select Yes and press Enter. A selection box displays 
over the image. 

4. Use the pointer button to select the area of the image you 
want to use. Then press Enter.

5. When you see the message Select this Image?, highlight Yes 
and press Enter. 

6. Use the arrow buttons to select a zoom factor (display size) and 
press Enter.

7. When the message Save this image as the user’s logo? 
appears, select Yes and press Enter. Saving the logo may take a 
few moments. Do not use your projector, remote control, or 
video source while the logo is being saved.

8. When you see the message Completed, press Menu to exit the 
menu system. 

note
When you choose an image 
for the user’s logo, it erases 
any previously used image. 
You can save an image up to 
300 × 400 pixels in size.
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Choosing When to Display the Image

After your image is saved, you can set it to display as the startup 
screen, the screen you see when there’s no signal, or the screen you see 
when you press the A/V Mute button (see page 29).

1. Press the Menu button, highlight the Extended menu, and press 
Enter. 

2. Select Display and press Enter.

3. Choose from these display options:

■ Set Display Background to Logo to display your image 
when there is no signal. 

■ Set Startup Screen to On to display your image when the 
projector is warming up. 

■ Set A/V Mute to Logo to display your image when you press 
the A/V Mute button. 

4. When you’re finished, press Menu to exit. 

Disabling the Projector’s Buttons

When you enable the Operation Lock function, you can lock all the 
projector’s buttons, or all buttons except the Power button. The 
remote control can still be used to operate the projector.

1. Press the Menu button, highlight the Settings menu, and press 
Enter.

2. Select Operation Lock and press the Enter button.

3. Select Full Lock (to lock all projector buttons) or Partial Lock (to 
lock all buttons except the Power button) and press Enter.

4. Select Yes and press Enter to confirm the setting.

5. Press the Menu button to exit. 

To disable the Operation Lock function, select Off in the Operation 
Lock menu. Or press and hold the Enter button on the projector’s 
control panel for 7 seconds. A message is displayed and the lock is 
released.

note
You can lock these settings to 
prevent them from being 
changed without a password 
(see page 55). 
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Customizing Power and Operation
You can use the Extended menu to customize the way the projector 
displays images, enable quick startup, turn sleep mode on or off, and 
customize other projector operations.

■ Display
Use this setting to turn off the display of messages, change the 
background color, enable logo display, or turn off the startup 
screen display.

■ User’s Logo
Create a custom startup screen, as described on page 57.

■ Projection 
Select Front (to project from the front of a screen and right side 
up), Front/Ceiling (when the projector is mounted upside-down 
from the ceiling), Rear (to project from behind onto a 
transparent screen), or Rear/Ceiling (to project from behind onto 
a transparent screen when the projector is mounted upside-down 
from the ceiling). 

■ Operation
Enable Direct Power On if you want to have the projector start 
when the power cable is connected (without pressing the Power 
button). Enable Sleep Mode if you want to have the projector 
turn off automatically if it is idle (and no signal is received) for 30 
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minutes or when the A/V mute slide (lens cover) is closed. Enable 
High Altitude Mode when you are using the projector above 
4900 ft (1500 m). 

■ Standby Mode
This function is not used for the PowerLite 1810p.

■ Projector ID
Lets you assign a numeric ID to each projector. When you are 
using multiple projectors, you can use the ID to select the one you 
want to operate with the remote control. See page 33 for 
instructions.

■ Multi-screen
Use this option if you want to color-match two or more projectors 
that are being used to display images near each other. You can 
make image adjustments at each of five adjustment levels. First 
choose an Adjustment Level and then adjust the settings for 
each level: Brightness Correct. to adjust the brightness, and 
Color Correct. to adjust the balance between red and green, or 
blue and yellow. See page 62 for more information about 
multi-screen color adjustment.

■ Language 
Select from nine languages to be used for the projector menus.

note
If Direct Power On is 
enabled, the power cable is 
connected, and a power 
outage occurs, the projector 
will start when the power is 
restored.

Do not use the projector at 
altitudes above 7500 ft 
(2,286 m).
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Multi-screen Color Adjustment
You can match the color of projected images when two or more 
projectors are being used to display images near each other. For each 
screen, you can set five levels of brightness and color correction.

1. Before starting, you may want to assign a numeric ID to each 
projector. This lets you use the remote control to select the 
projector you want to adjust. See page 33 for instructions.

To match the display colors as closely as possible, make sure that 
all the projectors are set to the same color mode before starting. 
See page 50 for instructions.

2. Press the Menu button on the remote control. You see the 
projector’s menu screen. 

3. Select Extended > Multi-screen.

4. Start by setting the Adjustment Level to 1 for two projectors. 
Then use Brightness Correct. to match the darker projector to 
the lighter one. Press Enter to see the effects of your adjustments.

5. Next, adjust the brightness of Level 5 for the same two projectors. 
Match the brighter projector to the darker one.

6. Adjust and match the brightness of Levels 2, 3, and 4. 

7. Adjust and match the G/R color correction for all levels. Then 
adjust and match the B/Y correction for all levels. 

8. If you are using three or more projectors, repeat steps 4 through 7 
to match projector 3 to projector 2, then match projector 4 to 
projector 3, and so on.

note
If you use two or more 
projectors side-by-side, 
exhaust from adjacent 
projectors might cause 
overheating. Leave at least 
2 feet (60 cm) of space 
between projectors.
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5

Maintaining the Projector
Your projector needs little maintenance. All you have to do is keep 
the lens clean. You may also need to clean the air filter and vent. A 
clogged air filter or vent can block ventilation needed to cool the 
projector.

The only parts you should replace are the lamp and air filter. If any 
other part needs replacing, contact your dealer or a qualified servicer.

This chapter covers the following:

■ Cleaning the lens

■ Cleaning the projector case

■ Cleaning the air filter and vent

■ Replacing the lamp and air filter

■ Replacing the remote control batteries

■ Transporting the projector

warning
Before you clean any part of 
the projector, turn it off and 
unplug the power cord. 
Never open any cover on the 
projector, except the lamp 
cover. Dangerous electrical 
voltages in the projector can 
injure you severely. Do not 
try to service this product 
yourself, except as specifically 
explained in this User’s 
Guide. Refer all other 
servicing to qualified service 
personnel.
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Cleaning the Lens
Clean the lens whenever you notice dirt or dust on the surface.

Use a canister of compressed air to remove dust.

To remove dirt or smears on the lens, use lens-cleaning tissue. If 
necessary, moisten a soft cloth with lens cleaner and gently wipe the 
lens.

Cleaning the Projector Case
Before you clean the case, turn off the projector and unplug the power 
cord.

■ To remove dirt or dust, wipe the case with a soft, dry, lint-free 
cloth.

■ To remove stubborn dirt or stains, moisten a soft cloth with water 
and a neutral detergent. Then wipe the case.

caution
Do not use wax, alcohol, 
benzene, paint thinner, or 
other chemical detergents. 
These can damage the case.
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Cleaning the Air Filter and Vent
Your projector includes an air filter to ensure the best performance. If 
dust collects on the air filter (on the bottom of the projector) or vent 
(on the front of the projector), clean them as described below. Dust 
clogs prevent proper ventilation and can cause overheating and 
damage the projector.

Follow these steps:

1. Turn off the projector and unplug the power cord.

2. To clean the intake vent and filter, use a small vacuum cleaner 
designed for computers and other office equipment. If you don’t 
have one, gently clean the vent with a soft brush (such as an 
artist’s paintbrush).

You can remove the air filter to clean both sides (see page 68).

3. If the dirt is difficult to remove or the filter is broken, replace the 
filter as described on page 68. Contact your dealer or call Epson at 
800-GO-EPSON (800-463-7766) to obtain a new filter. 

note
To order replacement air 
filters, request part number 
V13H134A08. See page 11 
for ordering information.

Air filter

Vent
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Replacing the Lamp and Air Filter
The life span of the projection lamp is about 2500 hours if 
Brightness Control in the Settings menu is set to High (default), and 
3000 hours if Brightness Control is set to Low. See page 69 to check 
the lamp usage. 

It is time to replace the lamp when: 

■ The projected image gets darker or starts to deteriorate.

■ The message Replace the lamp appears on the screen when the 
lamp comes on and the lamp warning light  flashes orange. To 
maintain projector brightness and image quality, replace the lamp 
as soon as possible. 

■ The lamp warning light  flashes red (the lamp is burnt out).

Contact your dealer or call Epson at 800-GO-EPSON 
(800-463-7766). Request part number V13H010L40. 

note
When you get a replacement 
lamp for your projector, you 
should replace the filter.

Turn off this product when 
not in use to prolong the life 
of the projector. 

Lamp warning light
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Follow these steps to replace the lamp and air filter:

1. Turn off the projector and unplug the power cord.

2. Let the projector cool for at least an hour (if it has been on). The 
lamp is extremely hot immediately after use. 

3. Loosen the lamp cover screw (you don’t need to remove it). Then 
slide the lamp cover to the side and lift it off of the projector. 

4. Loosen the two screws holding the lamp in place (you can’t 
remove them).

warning
Let the lamp cool fully 
before replacing it. 

In the unlikely event that 
the lamp has broken, small 
glass fragments may be 
present and should be 
removed carefully to avoid 
injury.

If the lamp is used after the 
replacement period has 
passed, the possibility that 
the lamp may break 
increases. When a lamp 
replacement message 
appears, replace the lamp 
with a new one as soon as 
possible, even if it is still 
working.

Loosen, but don’t 
remove these screws
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5. Hold the lamp as shown and pull it straight out.
 

6. Gently insert the new lamp. (If it doesn’t fit easily, make sure it is 
facing the right way.) 

7. Once the lamp is fully inserted, tighten its screws. 

8. Replace the lamp cover, then tighten its screw. 

9. Slide out the air filter on the bottom of the projector and 
remove it.

10. Slide in the new air filter until it clicks in place.

11. Reset the lamp timer as described in the next section. 

note
The lamp(s) in this 

product contain mercury. 
Please consult your state and 
local regulations regarding 
disposal or recycling. Do not 
put in the trash.
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Resetting the Lamp Timer

After you replace the lamp, you need to reset the lamp timer using the 
projector’s menus. 

1. Press the Menu button on the remote control or on the 
projector’s control panel. You see the main menu.

2. Use the pointer button on the remote control (or the arrow 
buttons on the projector) to highlight Reset, then press Enter. 

You see this screen: 

3. Select Reset Lamp Hours and press Enter. 

4. When you see the prompt, select Yes and press Enter.

5. When you’re finished, press Menu to exit the menu system. 

Checking Lamp Usage 

To check the number of hours the lamp has been used, press the 
Menu button and highlight the Info menu. You see a screen like this:

note
The information displayed 
depends on the input signal 
currently selected.
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The life span of the lamp is about 2500 hours if the Brightness 
Control setting in the Settings menu is set to High (default), and 
3000 hours if the Brightness Control setting is set to Low. Make 
sure you have a spare lamp handy if the usage hours on this menu 
are close to the life span of your lamp.

Replacing the Batteries
Replace the batteries in the remote control as described below: 

1. Turn the remote control over. 

2. Press down on the tab on the 
battery cover as you lift the cover 
off.

3. Install two AAA batteries, 
inserting the + and – ends as 
shown.

4. Position the cover as shown, then 
press down until it snaps into 
place.

caution
When replacing batteries, 
take the following 
precautions:

■ Replace the batteries as 
soon as they run out. If the 
batteries leak, wipe away 
battery fluid with a soft 
cloth. If fluid gets on your 
hands, wash immediately.

■ Do not expose batteries to 
heat or flame.

■ Dispose of used batteries 
according to local 
regulations.

■ Remove the batteries if 
you won’t be using the 
projector for a long period of 
time. 
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Transporting the Projector
The projector contains many glass and precision parts. Follow these 
guidelines to prevent damage: 

■ When shipping the projector for repairs, use the original 
packaging material if possible. If you do not have the original 
packaging, use equivalent materials, placing plenty of cushioning 
around the projector.

■ When transporting the projector a long distance, first place it in a 
hard-shell shipping case, then pack it in a firm box with 
cushioning around the case. 

■ Close the A/V mute slide (lens cover) to protect the lens. 

note
Epson shall not be liable for 
any damages incurred 
during transportation.

User's Guide - 1810.book  Page 71  Monday, September 10, 2007  6:39 PM



72 Maintaining the Projector

User's Guide - 1810.book  Page 72  Monday, September 10, 2007  6:39 PM



73
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Solving Problems
This chapter helps you solve problems with your projector, and tells 
you how to contact technical support for problems you can’t solve 
yourself. The following information is included:

■ Using the projector’s on-screen help system

■ What to do when the projector’s status lights flash

■ Solving projector operation problems

■ Solving problems with the image or sound

■ Solving problems with the remote control

■ Contacting technical support
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Using On-Screen Help
If the image doesn’t look right or your audio isn’t working, you can 
get help by pressing the ? Help button on top of the projector or on 
the remote control.

1. Press the ? Help button on the remote control or on the 
projector. 

You see the Help menu:

2. Use the  pointer button on the remote control or the 
navigational buttons on the projector to highlight menu items.

3. Press the Enter button on the remote control or on the projector 
to select the menu item. 

4. To exit the help system, press the ? Help button.

If none of the suggestions solve your problem, see additional solutions 
to problems in the following sections.
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Checking Projector Status
If your projector isn’t working correctly, first turn it off, wait for it to 
cool (the Power light stops flashing orange), and unplug it. Then 
plug the power cord back in and turn on the projector. If this doesn’t 
solve the problem, check the lights on top of the projector.

What To Do When the Lights Flash

The lights on top of the projector indicate the projector’s status.

Refer to the following table for a complete description of the 
projector’s status lights:

Temperature 
light

Lamp light

Power light

Status lights

Light Status Description

Orange The projector is in sleep or standby mode. You can unplug it or press the 
P Power button to turn it on.

Flashing green The projector is warming up. Wait for the image to appear.

Green The projector is operating normally.

Flashing orange The projector is cooling down. You can’t turn it back on until the light 
stops flashing and remains orange. 

Red There is a problem with the projector. Check the other two lights and the 
information on page 76 to diagnose the problem. 
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Flashing orange Rapid cooling is in progress. Although this is not an abnormal condition, 
projection will stop automatically if the temperature rises higher. Make 
sure there is plenty of space around and under the projector for 
ventilation, and that the air filter and vents are clear.

Red The projector is overheating, which turns the lamp off automatically. 
Wait until the cooling fan stops, then unplug the power cord. Plug the 
power cord back in and press the P Power button. Make sure the room 
temperature is not above 95 °F (35 °C), and there is plenty of space 
around and under the projector for ventilation. 

If you’re using the projector above an altitude of 5000 feet (1500 m), 
turn on High Altitude Mode in the Operation menu (see page 60).

The air filter or vents may be clogged. Clean them or replace the air filter 
as described on pages 65 to 68.

If the projector continues to overheat after you clean the air filter, the 
problem may be caused by damage to the cooling fan or temperature 
sensor. Contact Epson for help as described on page 83.

Warning: Except as specifically explained in this User’s Guide, do not 
attempt to service this product yourself.

Flashing red There is a problem with the fan or temperature sensor. The air filter or 
vents may be clogged. Clean them or replace the air filter as described on 
pages 65 to 68.

If this does not resolve the problem, stop using the projector, disconnect 
the power cable, and contact Epson as described on page 83.

Flashing orange It’s time to replace the lamp. See page 66 for instructions. If you continue 
to use the lamp after the replacement warning, there is an increased 
possibility that the lamp may break.

Flashing red The lamp may be burnt out. First make sure the lamp cover is securely 
installed. If that’s not the problem, let the lamp cool, remove the lamp, 
and replace it as described on page 66. 

The air filter or vents may be clogged. Clean them or replace the air filter 
as described on pages 65 to 68.

If this does not resolve the problem, contact Epson as described on 
page 83.

Flashing red Power is cut off because of an internal problem. Unplug the power cord 
and contact Epson for help, as described on page 83.

Status lights (continued)

Light Status Description
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Solving Projector Operation Problems

The power doesn’t turn on.

■ If the projector doesn’t turn on when you press the PPower 
button, make sure the power cable is connected to the projector 
and plugged into a working electrical outlet.

■ The power cable may be defective. Disconnect the cable from the 
outlet and contact Epson as described on page 83.

■ Check to see if the A/V mute slide (lens cover) is closed. 

The buttons on the projector don’t work.

If the Operation Lock function has been enabled, you can’t use the 
buttons on the projector. Try using the remote control instead. See 
page 59 for information about the Operation Lock function.

Solving Problems with the Image 
or Sound

No image appears on the screen.

■ Check that the Power light is green, not flashing. 

■ The projector may be in standby or sleep mode. If the Power 
light is orange, press the PPower button to turn the projector 
on.

■ If the power was switched off and then on again, the projector 
may be cooling down. Wait until the Power light stops flashing 
and remains orange; then press the PPower button again.

■ Press the A/V Mute button on the remote control to make sure 
the picture has not been turned off temporarily. 

■ Open the A/V mute slide (lens cover), if it is closed. 

■ The attached computer may be in sleep mode or displaying a 
black screen saver. Try pressing a key on the computer.
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■ If you are projecting from a DVD player or other video source, 
make sure you turn it on and press its Play button.

You’ve connected a computer and see a blue screen with the 
message No Signal displayed.

■ Make sure the cables are connected correctly, as described on 
page 36.

■ If you’ve connected a computer and one or more video sources, 
you may need to press the Source Search button on the 
projector or one of the source buttons on the remote control to 
select the correct source. Allow a few seconds for the projector to 
sync up after pressing the button.

If you’re using a PC notebook: 

■ Hold down the Fn key on the keyboard and press the function 
key that lets you display on an external monitor. It may have an 
icon such as , or it may be labelled CRT/LCD. Allow a few 
seconds for the projector to sync up after pressing it. Check your 
notebook’s manual or online help for details. 

On most systems, the  key lets you toggle between the LCD 
screen and the projector, or display on both at the same time.

■ Depending on your computer’s video card, you might need to use 
the Display utility in the Control Panel to make sure that both the 
LCD screen and external monitor port are enabled. See your 
computer’s documentation or online help for details.

If you’re using Mac OS X: 

1. Open System Preferences. 

2. Click Displays.

3. Click Detect Displays. 

4. Make sure the VGA Display or Color LCD dialog box is selected.

5. Click the Arrangement or Arrange tab.

6. Make sure the Mirror Displays checkbox is selected. 
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The message Not Supported is displayed.

■ Make sure the correct input signal is selected in the Signal menu 
(see page 52).

■ Make sure your computer’s resolution doesn’t exceed UXGA 
(1600 × 1200) and the frequency or refresh rate is supported by 
the projector (see page 89). If necessary, change your computer’s 
resolution setting. 

Only part of the computer image is displayed.

■ Press the Auto button on the remote control.

■ Make sure the image Position setting is correct in the Signal 
menu. See page 53 for more information.

■ Press the Resize button on the remote control.

■ Press the Esc button on the remote control to cancel the E-Zoom 
function.

■ Make sure your computer’s resolution setting is correct. Ideally, it 
should be 1024 × 768 to match the projector’s native resolution. 
If this option isn’t available, select one of the other compatible 
video formats listed on page 89.

■ You also may need to modify existing presentation files if you 
created them for a different resolution. See your software 
documentation for specific information.

The image isn’t square, but keystone-shaped.

■ If the image isn’t square or rectangular, adjust its shape as 
described on page 22.

■ Enable the Auto Keystone feature to automatically fix the shape 
when the projector is tilted upward. See page 54. 
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The image contains static or noise.

■ If you’re using a computer cable longer than 6 feet, or an 
extension cable, the image quality may be reduced.

■ Keep your computer and video cables away from the power cord 
as much as possible to prevent interference.

■ The video signal may be split between the computer and the 
projector. If you notice a decline in the projected image quality 
when the image is displayed simultaneously on your notebook 
computer and the projector, turn off the notebook’s LCD display.

■ Make sure the correct input signal is selected in the Signal menu 
(see page 53).

■ If you’ve used the Quick Setup, Quick Corner, or Keystone 
adjustment, you may need to decrease the Sharpness setting in 
the Image menu (see page 51).

The image is blurry.

■ There may be dirt or smears on the lens. Clean the lens as 
described on page 64.

■ Adjust the focus using the focus ring (see page 22).

■ If the projector is angled sharply toward the screen, it may not be 
possible to focus the entire image. Move the projector to position 
it more directly in front of the screen.

■ Make sure the projector is within the proper range (projection 
distance) from the screen (see page 87).

■ Make sure the lens is not fogged by condensation. You may need 
to wait before using the projector after moving it from a cold 
environment to a warm environment.

■ If you’re projecting from a computer, you may need to adjust the 
tracking and sync as described in the next section. 

User's Guide - 1810.book  Page 80  Monday, September 10, 2007  6:39 PM



Solving Problems 81

You see vertical bands or the image still looks blurry after 
trying the solutions in the previous section.

■ If you’re projecting from a computer and displaying an image that 
contains a lot of fine detail, you may notice vertical bands or some 
of the characters may look heavy or blurred. Press the Auto 
button on the remote control or the Enter button on the 
projector to reset the projector’s Tracking, Sync, and Position 
settings.

■ If further adjustment is needed, you can fine-tune the Tracking 
and Sync settings manually using the Signal menu, as described 
on page 53.

1. Fill the screen with an image containing fine detail, such as a 
pattern to appear as your desktop background, or try 
projecting black text on a white background.

2. Adjust the Tracking to eliminate vertical bands. 

3. Adjust the Sync setting to increase the image sharpness. 

The image is too light or dark, or colors are incorrect.

■ Use the Color Mode option in the projector’s Image menu to 
adjust the color (see page 50). 

■ If you’re displaying video, adjust the Color Adjustment and 
Color Mode settings on the Image menu. You can also try 
adjusting the Color Saturation, ABS Color Temp, and Tint 
settings on the Image menu.

note
You must be projecting an 
image for this button to have 
any effect. The Auto button 
works only with computer 
images projected through the 
VGA port.

note
Because of the different 
technologies used, your 
projected image may not 
exactly match the colors on 
your notebook or computer 
monitor.
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■ Try adjusting the Brightness and Contrast settings on the Image 
menu.

■ Check your computer display settings to correct the color balance.

■ The projector’s lamp may need to be replaced. See page 66 for 
instructions.

■ Make sure the correct input signal is selected in the Signal menu 
(see page 53).

There is no sound, or the sound is not loud enough.

■ Use the Volume buttons on the remote control to adjust the 
volume, or adjust the Volume setting in the Settings menu (see 
page 54).

■ Make sure A/V Mute is not enabled. (The A/V Mute button may 
have been pressed.) 

■ Make sure the A/V mute slide (lens cover) is open.

■ If your presentation includes computer audio, make sure the 
volume control on your computer is not turned all the way down 
or muted. In Windows, you may be able to check this by clicking 
the volume control in your Windows system tray (lower right 
corner of the screen). On a Mac, you may be able to adjust the 
volume from your menu bar (top right corner of the screen) or via 
the volume control function keys.

■ If you’re using a DVD player or other video source, make sure the 
cables are connected correctly, as described on page 44.

■ If you’re using a computer audio cable, make sure it is connected 
to your computer’s headphone jack or  audio out jack. 
Connect the other end to the projector’s Audio1 port when the 
computer’s video cable is connected to the Computer1 port. 
Otherwise, connect the cable to Audio2 if you’re using 
Computer2 for the computer’s video connection. 
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Solving Problems with the Remote 
Control

The projector doesn’t respond to remote control commands.

■ The remote control’s batteries may not be installed correctly or 
may be low on power. To change the batteries, see page 70. 

■ Make sure you are within about 20 feet (6 meters) of the projector 
and within range of the projector’s front or back sensor 
(approximately 30° to the left or right and 15° above or below).

■ Dim the room lights and turn off any fluorescent lights. Make 
sure the projector is not in direct sunlight. Strong lighting, 
especially fluorescent lights, may affect the projector’s infrared 
receivers. Also, turn off any nearby equipment that emits infrared 
energy, such as a radiant room heater. If necessary, use the 
Remote Receiver setting to disable the projector’s front or back 
sensor if it continues to pick up interference (see page 55).

■ Make sure the Remote Receiver setting isn’t disabling both of 
the projector’s sensors (see page 55).

■ If any buttons are held for longer than 30 seconds, the remote 
enters sleep mode. Release any button that is held to wake the 
remote. 

Where To Get Help
Epson provides these technical support services:

Internet Support 

Visit Epson’s support website for solutions to common problems. You 
can download utilities and documentation, get FAQs and 
troubleshooting advice, or e-mail Epson with your questions.

Visit Presenters Online to access tips, templates, and training for 
developing successful presentations.
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Speak to a Support Representative

To use the Epson PrivateLine Support service, call (800) 637-7661 
and enter the PIN on the included Epson PrivateLine Support card. 
This is the fastest way of speaking to a live representative, and it’s free. 
This service is available 6 AM to 6 PM, Pacific Time, Monday through 
Friday, for the duration of your warranty period.

You may also speak with a projector support specialist by dialing one 
of these numbers:

■ U.S.: (562) 276-4394, 6 AM to 6 PM, Pacific Time, Monday 
through Friday. 

■ Canada: (905) 709-3839, 6 AM to 6 PM, Pacific Time, Monday 
through Friday.

Days and hours of support are subject to change without notice. Toll 
or long distance charges may apply.

Before you call for support, please have the following information 
ready:

■ Product name (PowerLite 1810p)

■ Product serial number (located on the projector)

■ Proof of purchase (such as a store receipt) and date of purchase

■ Computer or video configuration

■ Description of the problem

Purchase Supplies and Accessories

You can purchase screens or other accessories from an Epson 
authorized reseller. To find the nearest reseller, call 800-GO-EPSON 
(800-463-7766). Or you can purchase online at www.epsonstore.com 
(U.S. sales) or www.epson.ca (Canadian sales).
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Projector Installation
This appendix provides guidelines on installing the projector in a 
permanent location, such as a theater or conference room.

The projector can be installed for four different viewing setups: front 
projection, ceiling projection, rear projection onto a semi-transparent 
screen, or rear/ceiling projection, as shown: 

To project from overhead, you’ll need the optional ceiling mounting 
hardware (see page 11). You’ll also need to select the appropriate 
Projection setting in the projector’s Extended menu to flip the image 
upside-down (see page 60).

If you’re mounting the projector on the ceiling and you place it above 
screen level, you’ll have to tilt the projector down to position the 
image on the screen. This causes the image to lose its square shape. 
You can correct the image using the projector’s Quick Setup, Quick 
Corner, and/or Keystone functions, as described on page 22.

Front projection Rear projection

Rear/ceiling projectionCeiling projection
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The projector includes security features to prevent its theft when 
installed or used in public locations: 

■ Security cable attachment You can attach a commercially 
available security cable as shown below to secure the projector to a 
table or ceiling mount.

■ Kensington security slot The security slot is compatible with 
the MicroSaver security systems manufactured by Kensington. 
You can purchase this lock from Epson (see page 11).

In addition, the projector includes several menu-operated security 
features. See page 55.

Kensington security 
slot

Security cable 
attachment
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Technical Specifications
General

Type of display Epson poly-silicon TFT active matrix

Resolution
(native format) 1024 × 768 pixels (XGA)

Color reproduction 16.8 million colors

Brightness 3500 lumens (High Brightness mode)
2700 lumens (Low Brightness mode)

Contrast ratio 500:1

Image size 30 to 300 inches

Projection distance 2.7 to 48.2 feet (0.8 to 14.7 meters)

Projection methods Front, rear, upside-down (ceiling mount)

Internal sound system 5 W monaural

Optical aspect ratio 4:3 (horizontal:vertical)

Zoom ratio 1:1.6

Noise level 32 dB in Low Brightness mode, 37 dB in 
High Brightness mode 

Keystone correction ±30° vertical (automatic/manual)
±20° horizontal (manual)

Mouse compatibility Supports USB (type B)
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Projection Lamp

Type UHE (Ultra High Efficiency)

Power consumption 210 W

Lamp life Approx. 2500 hours (High Brightness 
mode)
Approx. 3000 hours (Low Brightness mode)

Part number V13H010L40 

Remote Control

Range 20 feet (6 meters)

Batteries (2) Alkaline AAA

Dimensions

Height 3.4 inches (86 mm), feet retracted 

Width 13.6 inches (345 mm)

Depth 10.1 inches (257 mm)

Weight 6.5 lb (2.9 kg)

Electrical

Rated frequency 50/60 Hz AC

Power supply 100 to 120 VAC, 3.4 A
200 to 240 VAC, 1.5 A

Power consumption Operating: 
100 to 120 VAC, 306 W
220 to 240 VAC, 286 W

Standby: 
100 to 120 VAC, 2.6 W
220 to 240 VAC, 4.6 W

note
Lamp life results will vary 
depending upon mode 
selected, environmental 
conditions, and usage. 

Turn off this product when 
not in use to prolong the life 
of the projector. 
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Environmental

Temperature Operating: 41 to 95 °F (5 to 35 °C)
Storage: 14 to 140 °F (–10 to 60 °C)

Humidity
(non-condensing) Operating: 20 to 80% RH

Storage: 10 to 90% RH

Operating altitude 0 to 7,500 ft (0 to 2,286 m)

Safety and Approvals

United States FCC 47CFR Part 15B Class B (DoC)
UL60950 Third Edition

Canada ICES-003 Class B
CSA C22.2 No. 60950

CE Marking Directive 73/23/EEC
Directive 89/336/EEC
IEC 60950 Third Edition
EN 55022, EN 55024

 Pixelworks™ DNX™ ICs are used in this projector.

Compatible Video Formats

The projector supports the high definition video and computer 
display formats listed below, as well as traditional NTSC, PAL, and 
SECAM video standards.

To project images output from a computer, the computer’s video card 
must be set at a refresh rate (vertical frequency) that’s compatible with 
the projector. Some images are automatically resized using Epson’s 
SizeWizeTM technology to display in the projector’s native format 
(XGA). The frequencies of some computers may not allow images to 
display correctly; see your computer’s documentation for details.
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Compatible video formats
Mode Refresh Rate (Hz) Resolution

VGA EGA 70 640 × 350

VGA—60
VESA—72
VESA—75
VESA—85
VGA—120

60
72
75
85
120

640 × 480
640 × 480
640 × 480
640 × 480
640 × 480

SVGA—56
SVGA—60
SVGA—72
SVGA—75
SVGA—85
SVGA—120

56
60
72
75
85
120

800 × 600
800 × 600
800 × 600
800 × 600
800 × 600
800 × 600

XGA—60
XGA—70
XGA—75
XGA—85
XGA—120

60
70
75
85
120

1024 × 768
1024 × 768
1024 × 768
1024 × 768
1024 × 768

SXGA1—70
SXGA1—75
SXGA1—85
SXGA1—120

70
75
85
120

1152 × 864
1152 × 864
1152 × 864
1152 × 864

SXGA2—60
SXGA2—75
SXGA2—85
SXGA+60
SXGA+75
SXGA+85

60
75
85
60
75
85

1280 × 960
1280 × 960
1280 × 960
1400 × 1050
1400 × 1050
1400 × 1050

SXGA3—60
SXGA3—75
SXGA3—85

60
75
85

1280 × 1024
1280 × 1024
1280 × 1024

UXGA—60 60 1600 × 1200

iMAC VGA
iMAC SVGA
iMAC XGA
MAC13
MAC16
MAC19
MAC19-60
MAC21

117
95
75
67
75
75
59
75

640 × 480
800 × 600
1024 × 768
640 × 480
832 × 624
1024 × 768
1024 × 768
1152 × 870
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NTSC 
NTSC 4:43
PAL
N-PAL
M-PAL
PAL—60
SECAM

60
60
50
50
60
60
50

—
—
—
—
—
—
—

HDTV (720p)
HDTV (720p)
HDTV (1080i)
HDTV (1080i)

60
50
60
50

—
—
—
—

TV480i
TV625i
SDTV (480p)
SDTV (576p)

60
50
60
50

—
—
—
—

Compatible video formats  (continued)
Mode Refresh Rate (Hz) Resolution
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Notices
This appendix includes safety instructions and other important information 
about your projector.

Important Safety Instructions
Follow these safety instructions when setting up and using the projector:

■ Do not look into the lens when the projector is on. The bright light can 
damage your eyes.

■ Do not place the projector on an unstable cart, stand, or table.

■ Do not operate the projector on its side, or while tilted to one side. 
Do not tilt the projector forward or back at a greater angle than that 
specified for vertical keystone correction (see page 87). 

■ If the projector is mounted on a ceiling, it should be installed by 
qualified technicians using mounting hardware designed for use with 
this projector. 

■ Do not stand on the projector or place heavy objects on it.

■ Do not use the projector where it may be exposed to rain, water, or 
excessive humidity. 

■ Unplug the projector from the wall outlet before cleaning. Use a damp 
cloth for cleaning. Do not use liquid or aerosol cleaners.

■ Never spill liquid of any kind into the projector.

■ Do not use the projector where it may be exposed to excessive dust or 
smoke.

■ Never push objects of any kind through the cabinet slots. 

■ Do not use or store the projector or remote control in a hot location, 
such as near a heater, in direct sunlight, or in a closed vehicle.

■ Do not block the slots and openings in the projector case. They provide 
ventilation and prevent the projector from overheating. Do not operate 
the projector on a sofa, rug, or other soft surface, or set it on top of loose 
papers, which could block vents underneath your projector. 
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■ Do not operate the projector in a closed-in cabinet unless proper 
ventilation is provided.

■ If you are using two or more projectors side-by-side, leave at least 2 feet 
(60 cm) of space between the projectors to allow for proper ventilation.

■ You may need to clean the air filter and vent. A clogged air filter or vent 
can block ventilation needed to cool the projector.

■ Do not use the projector outside of the required temperature range of 
41 to 95 °F (5 to 35 °C). Doing so may cause an unstable display and 
could lead to projector damage.

■ Do not store the projector outside of the required temperature range of 
14 to 140 °F (–10 to 60 °C) or in direct sunlight for long periods of 
time. Doing so may cause damage to the case.

■ Unplug the projector during lightning storms or when it will not be used 
for extended periods.

■ Unplug the projector from the wall outlet and refer servicing to qualified 
service personnel under the following conditions: If it does not operate 
normally when you follow the operating instructions, or exhibits a 
distinct change in performance. If smoke, strange odors, or strange 
noises come from the projector. If the power cord or plug is damaged or 
frayed. If liquid or foreign objects get inside the projector, or if it has 
been exposed to rain or water. If it has been dropped or the housing has 
been damaged.

■ Except as specifically explained in this User’s Guide, do not attempt to 
service this product yourself. Refer all servicing to qualified personnel. 
Opening or removing covers may expose you to dangerous voltages and 
other hazards.

■ Use the type of power source indicated on the projector. If you are not 
sure of the power available, consult your dealer or power company.

■ If you use the projector in a country other than where you purchased it, 
use the correct power cord for that country.

■ Do not overload wall outlets, extension cords, or power strips. This can 
cause fire or electric shock.

■ Take the following precautions when handling the plug: Do not hold 
the plug with wet hands. Do not insert the plug into an outlet with dust 
present. Insert the plug firmly into the outlet.

■ Do not place the projector where the cord can be walked on.

■ The lamp(s) in this product contain mercury. Please consult your 
state and local regulations regarding disposal or recycling. Do not put in 
the trash.
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■ If the lamp breaks, ventilate the room to prevent gases contained in the 
lamp from being inhaled or coming in contact with the eyes or mouth.

■ If the projector is mounted overhead and the lamp breaks, be careful to 
prevent pieces of glass from falling into your eyes when you open the 
lamp cover.

WARNING: The cords included with this product contain chemicals, 
including lead, known to the State of California to cause birth defects or 
other reproductive harm. Wash hands after handling. (Provided in accordance 
with Proposition 65 in Cal. Health & Safety Code §25249.5 et seq.)

FCC Compliance Statement

For United States Users

This equipment has been tested and found to comply with the limits for a 
Class B digital device, pursuant to Part 15 of the FCC Rules. These limits are 
designed to provide reasonable protection against harmful interference in a 
residential installation. This equipment generates, uses, and can radiate radio 
frequency energy and, if not installed and used in accordance with the 
instructions, may cause harmful interference to radio or television reception. 
However, there is no guarantee that interference will not occur in a particular 
installation. If this equipment does cause interference to radio and television 
reception, which can be determined by turning the equipment off and on, 
the user is encouraged to try to correct the interference by one or more of the 
following measures:

■ Reorient or relocate the receiving antenna.

■ Increase the separation between the equipment and receiver.

■ Connect the equipment into an outlet on a circuit different from that to 
which the receiver is connected.

■ Consult the dealer or an experienced radio/TV technician for help.

WARNING

The connection of a non-shielded equipment interface cable to this 
equipment will invalidate the FCC Certification of this device and may cause 
interference levels which exceed the limits established by the FCC for this 
equipment. It is the responsibility of the user to obtain and use a shielded 
equipment interface cable with this device. If this equipment has more than 
one interface connector, do not leave cables connected to unused interfaces. 
Changes or modifications not expressly approved by the manufacturer could 
void the user’s authority to operate the equipment.
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For Canadian Users

This Class B digital apparatus meets all requirements of the Canadian 
Interference-Causing Equipment Regulations.

Cet appareil numérique de la classe B respecte toutes les exigences du Règlement 
sur le materiel brouilleur du Canada.
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Index

A
A/V Mute

button, 29
display settings, 59

Accessories, 11
Air filter

cleaning, 65
ordering, 11
replacing, 66 to 68

Altitude, 61, 76, 89
Anti-theft device, 11, 15, 86
Aspect ratio, 87
Audio

connecting equipment, 44 to 45
controlling volume, 31
problems, troubleshooting, 82
turning off (using A/V Mute), 29

Auto Setup setting, 53

B
Background screen settings, 59
Bands, vertical, 81
Blackboard color mode, 26, 51
Blackboard, projecting on, 25
Blank screen, 19 to 20
Blurry image, 80
Brightness, 87
Brightness control, 54
Brightness setting, 51

C
Cables

HD15-to-component, 10, 41
illustrations, 10
mouse, 37
ordering, 11
remote control cable set, 11
security, 86
S-video, 11, 40
VGA, 36
VGA-to-component, 10, 41

Capturing image, 58
Carrying case, 10
Ceiling mount, 11, 85
Cleaning

air filter, 65
lens, 64
projector case, 64

Color
correcting, 25
multi-screen adjustment, 62
problems, 81 to 82
saturation, 51
settings, 50 to 51
temperature, 51

Color Mode, 25 to 26, 50 to 51
Component video cable, 11, 38
Composite (RCA) video cable, 38 to 39
Computer

connecting to, 36 to 37
selecting source, 18

Connecting projector
to audio equipment, 44 to 45
to computer, 36 to 37
to external monitor, 43
to speakers, 45
to video equipment, 38 to 42

Contrast setting, 51
Custom screen, see User’s Logo
Customized color mode, 26, 51
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D
Default settings, restoring, 49
Direct Power On, 17
Distance from projector to screen, 14, 87
Documentation, 8
DVD player, connecting, 38 to 42

E
Electrical specifications, 88
Environmental specifications, 89
Epson

accessories, 11
presentation tips, 9
PrivateLine Support, 8
technical support, 8, 83 to 84
warranty, 9

External monitor, connecting, 43
E-Zoom button, 30

F
FCC compliance statement, 95
Filter, see Air filter
Focusing image, 22
Freeze button, 30

G
Game color mode, 26, 50

H
HDTV images, video formats, 91
Height of image, adjusting, 21
Help, 83 to 84
Help system, using, 74
Help, Epson, 8
High altitude, 61, 76

I
Image

adjusting, 21 to 26, 50 to 51
blurry, 80
capturing and saving in projector, 58
correcting shape, 22 to 25, 54, 79
fitting on screen, 53, 79
height, adjusting, 21
problems with, 77 to 82
projecting on chalkboard, 25
raising, 21
selecting source, 18, 28, 39 to 42
shape, correcting, 22 to 25
size and projection distance, 14, 87
turning off (using A/V Mute), 29
turning off temporarily, 29
zooming, 22, 30

Image menu, 50 to 51
Info menu, 69 to 70
Input signal, selecting, 18, 28, 39 to 42
Installing projector, 85 to 86
Instant Off, 18

K
Kensington anti-theft device, 11, 15, 86
Keystone correction, 22 to 25, 54, 79, 87

L
Lamp

number of hours used, 69 to 70
ordering, 11
replacing, 66 to 69
specifications, 88
status light, 75 to 76

Lamp timer, resetting, 69
Language setting, 61
Laptop computer

connecting to, 36 to 37
display problems, 19 to 20, 77 to 78
selecting source, 18, 28

Lens, cleaning, 64
Lights, status, 75 to 76
Logo, saving on projector, 57 to 59
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M
Mac

display problems, 78
Manuals, 8
Menus

changing settings, 48 to 49
default settings, restoring, 49
Image, 50 to 51
Info, 69 to 70
Signal, 52 to 53
User’s Logo, 58

Monitor, connecting, 43
Mouse

compatibility, 87
connecting cable for remote, 37
using remote control as, 32

Multiple projectors, controlling, 33 to 34
Multi-screen color adjustment, 62

N
No Signal message, 19, 78
Noise level, 87
Not Supported message, 79
Numeric keypad, using, 56

O
Operation Lock setting, 54, 59
Optical aspect ratio, 87
Options for projector, 11

P
Password

protection, 55 to 57
request code, 57

Photo color mode, 26, 50
Picture source, selecting, 18, 28, 39 to 42
Picture, see Image
Pointer shape, 54
Pointer tool, using, 31 to 32
Positioning

image, 21
projector, 14 to 15, 85 to 86

Power
button, 17
specifications, 88
status light, 17, 75 to 76

Presentation color mode, 26, 50
Presentations

computer, 36 to 37
room conditions, 14, 28
tips and training, 9
using the pointer tool, 31 to 32
video, 38 to 42

Presenters Online, 9
PrivateLine Support, 8
Problems

color, 81 to 82
image, 77 to 82
no signal, 19, 78
remote control, 83
sound, 82
using on-screen help, 74

Progressive format, 53
Projecting without screen, 25
Projection lamp, see Lamp
Projector

cleaning, 64
disabling buttons, 59
distance from screen, 14, 87
installing, 85 to 86
lamp specifications, 88
options, 11
password protection, 55 to 57
positioning, 14 to 15
resolution, 87
security features, 55 to 59, 86
specifications, 87 to 89
transporting, 71
troubleshooting, 73 to 76
turning off, 18
turning on, 15 to 17
unpacking, 10
viewing information about, 69 to 70

Projector ID, setting, 33 to 34
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Q
Quick Corner, 23, 54

R
Raising image, 21
Rear-screen projection, 60, 85
Registration, 9
Remote control

A/V Mute button, 29
as wireless mouse, 32
battery used, 88
connecting cable for mouse, 37
controlling multiple projectors, 33 to 34
correcting color, 25
E-Zoom button, 30
Freeze button, 30
ID, 34
numeric keypad, using, 56
pointer tool, using, 31 to 32
problems, 83
range, 88
specifications, 88
switching sources, 28
troubleshooting, 83

Remote Receiver setting, 55
Replacing lamp, 66 to 69
Request code, password, 57
Resetting lamp timer, 69
Resetting menu options, 49
Resize image, 26
Resolution, 26, 79, 87

S
Safety

instructions, 93 to 95
specifications, 89

Saturation setting, 51
Screen

blank, 19 to 20
distance from projector, 14, 87
ordering, 11
startup screen, creating, 57 to 58

Screen image, see Image

Security
cables, 86
identifying logo, 58 to 59
Kensington lock, 11, 86
Operation Lock, 59
password protection, 55 to 57

Sharpness setting, 51
Signal menu, 52 to 53
Six-axis color adjustment, 51 to 52
Sleep mode, 16
Sound

troubleshooting, 82
Source, selecting, 18, 28
Speaker, specifications, 87
Speakers, connecting, 45
Specifications

brightness, 87
dimensions, 88
electrical, 88
environmental, 89
general, 87
lamp, 88
remote control, 88
resolution, 87
safety, 89

Sports color mode, 26, 50
sRGB color mode, 26, 51
Startup screen

creating, 57 to 59
settings, 59
user’s logo, see User’s Logo

Status lights, 75 to 76
Support, see Technical support
S-video cable, 11, 40
Switching picture source, 18, 28
Sync setting, 53
Synchronization, adjusting, 81

T
Technical support, 8, 83 to 84
Temperature

requirements, 89
status light, 75 to 76

Temperature, color, 51
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Test pattern, displaying, 55
Text color mode, 26, 50
Theatre color mode, 26, 50
Tint setting, 51
Tracking, adjusting, 81
Transporting projector, 71
Troubleshooting

blank screen, 19 to 20, 77 to 78
cut-off image, 79
distorted image, 22 to 25
image and sound problems, 77 to 82
no signal, 19, 78
projector problems, 73 to 76
remote control problems, 83
tapered image, 22 to 25

Turning off picture (using A/V Mute), 29
Turning off projector, 18

U
Unpacking projector, 10
USB

cable, 10, 37
User’s Logo

creating, 58
display settings, 59

V
VCR, connecting, 38 to 42
Video

cables, 10, 11, 38
connecting video equipment, 38 to 42
formats, supported, 89 to 91
selecting source, 18, 28, 39, 40

Video Signal setting, 53
Volume, controlling, 31, 54

W
Warning lights, 75 to 76
Warranty, 9
Windows

display problems, 78
Wireless

module, 10
Wireless, mouse, 32, 37

Z
Zoom ratio, 87
Zooming image, 22, 30
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